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NEW QUESTION 1
- (Topic 3)
When a flow runs an action, it generates a runtime value, which stays the same for the duration of the flow. What is the name of this runtime value?

A. Trigger runtime value

B. Sequence runtime value
C. Starting runtime value
D. Data pill runtime value
E. Input runtime value

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/administer/flow-designer/concept/data-population.html

NEW QUESTION 2

- (Topic 3)

A user is complaining that they are seeing a blank page, when they click Create New, from your custom Inventory application. You have confirmed that they can
see the Inventory application, and the Create New module on the application navigator. What could be the cause of this issue?

A. Create New module has a broken link

B. Known intermittent issue with U115

C. User should be using Chrome instead of Explorer for their browser
D. User has read role, but not the write role on the Inventory table

E. User session has timed out

Answer: D

NEW QUESTION 3
- (Topic 3)
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Export )
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dd History )

Reload form

Which path would you take to access the table configuration page from a form?

A. The Form Context menu > View > Table

B. The Form Context menu > Configure > Table

C. The Form Context menu > Configure > Dictionary
D. The Form Context menu > View > Show Table

Answer: B

NEW QUESTION 4

- (Topic 3)

While showing a customer their incident form, they ask to change the Priority field title to display their internal terminology PValue. How would you do that? Choose

2 answers

A. Right click on Priority and select Configure Dictionary
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B. Right click on Priority and select Configure Display Settings
C. Right click on Priority and select Configure Label
D. Right click on Priority and select Configure Column

Answer: AC

NEW QUESTION 5
- (Topic 3)
When a custom table is created, which access control rules are automatically created? Choose 4 answers

A. delete
B. create
C. execute
D. read

E. update
F. write

Answer: ABDF

NEW QUESTION 6
- (Topic 3)
What role enables someone to authorize a request, with no other permissions on the platform?

A. Approver [approver-user]

B. Authorize [authorize-user]

C. Reviewer [reviewer_user]

D. Approver Group [approval_group]
E. Verification [verify_user]

Answer: A

NEW QUESTION 7
- (Topic 3)
Which tool graphically displays an infrastructure view for a configuration item (ClI) and its relationship with other Cls?

A. Schema Map

B. Dependency View
C. Dependency Map
D. Database View

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/business-service-management-map-
ng/concept/c_BusinesssServiceManagementMaps.html

NEW QUESTION 8
- (Topic 3)
The Report Designer contains different sections for configuring your report. Which section is used to specify grouping and calculations to be run against me data?

A. Style

B. Format
C. Data

D. Configure
E. Group by

Answer: D

NEW QUESTION 9
- (Topic 3)
What are examples of Core tables in the ServiceNow platform?

A. Configuration, Connect, Chat
B. Team, Party, Awards

C. User, Task, Incident

D. Work, Caller, Timecard

Answer: C
Explanation:

Reference: https://www.basicoservicenowlearning.in/2019/12/create-table-in- servicenow.html

NEW QUESTION 10
- (Topic 3)
On the Cl Dependency View, what enables you to trace from an infrastructure item, like a Server, to the Services that are dependent on that Server?
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A. Service Tracer

B. Automapping Utility
C. Relationships

D. Transform Map

Answer: C

NEW QUESTION 10
- (Topic 3)
Which modules can you use to create a new table? Choose 2 answers

A. Tables & Columns
B. Schema Map

C. Dictionary

D. Tables

Answer: AD

NEW QUESTION 13
- (Topic 3)
Which feature ensures data consistency white importing data using import sets and web services?

A. Client Script
B. Ul Policy

C. Data Policy
D. CSDM

E. Business Rule

Answer: C

Explanation:

Data policies are used to define rules that govern the creation, modification, and deletion of data in ServiceNow. These policies can be used to ensure data
consistency by enforcing data quality standards and preventing invalid or inaccurate data from being imported.

References:

? ServiceNow Product Documentation: Data policies overview - https://docs.servicenow.com/bundle/vancouver-platform-
administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 17
- (Topic 3)
When importing data from a spreadsheet, which step defines where the incoming data columns will be written in the receiving table?

A. Field Matching

B. Load Data

C. Select Data Source

D. Schedule Transform
E. Create Transform Map

Answer: E

Explanation:

A transform map is a set of field maps that define the relationships between fields in an import set and fields in an existing tablel. When importing data from a
spreadsheet, creating a transform map is the step that defines where the incoming data columns will be written in the receiving table2. The transform map allows
users to specify how to transform the source data into the target data, such as by using scripts, coalescing, or mapping assist1.

References

? Transform Maps - Product Documentation: San Diego - ServiceNow1

? Importing Data: Excel to ServiceNow - Finite Partners2

NEW QUESTION 21
- (Topic 3)
When using Flow Designer what is the Flow Execution initiated by?

A. A trigger

B. An existing subflow
C. Allow logic

D. An execution data pill

Answer: A

Explanation:

A trigger is an activity that, once specified, automatically initiates a flowl. A trigger specifies the conditions that start running the flow, such as creating a record in
a specified table, receiving an inbound email, or reaching an SLA target1.

References

? Flow trigger types - Product Documentation: San Diego - ServiceNow1

NEW QUESTION 23

- (Topic 3)

You have been asked to create a way for users to order a new iPhone, but only if they get two levels of approval. The approvers and users should be automatically
notified at each approval level. What feature would you use to manage the approvals and notifications?
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A. Parent-Child Approvers.
B. Approval Chains

C. Flows

D. Approval Criteria

E. Approver Delegates

Answer: D

NEW QUESTION 25
- (Topic 3)
What are the components that make up a filer condition? Choose 3 answers

A. Column

B. Match Criteria
C. Field

D. Value

E. Operator

Answer: C

NEW QUESTION 27
- (Topic 3)
Tables may have a One to Many relationships. From the Service Catalog, what are examples of tables having a one to many relationships? (Choose three.)

A. One Approval can have many Requests

B. One Request can have many Requested Items

C. One Requested Item can have many Approvals

D. One Requested Item can have many Catalog Tasks
E. One Cart can have many Requests

Answer: BDE

NEW QUESTION 32
- (Topic 3)
After finishing your work on High Security Settings, what is a possible way to return to normal admin security levels?

A. Use System Administration > Normal Security module
B. Select Normal role

C. Log out and back in

D. Select Global Update Set

E. End impersonation

Answer: A

Explanation:

The System Administration > Normal Security module is the recommended way to return to normal admin security levels after finishing your work on High Security
Settings. This module will automatically disable all high security settings and restore your permissions to their original state.

References:

? ServiceNow Product Documentation: High Security Settings - https://docs.servicenow.com/bundle/vancouver-platform-
security/page/administer/security/reference/high-security-plugin.html

? ServiceNow Community: How to disable High Security Settings - https://www.servicenow.com/community/now-platform-forum/platform-security-everything-you-
need-to-know/m-p/2554570

NEW QUESTION 35
- (Topic 3)
What ServiceNow feature can be triggered by events, and is used to inform users about activities or updates in ServiceNow?

A. Notifications
B. Alerts

C. Texts

D. Events

E. Emails

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/platform-events/concept/events.html

NEW QUESTION 40

- (Topic 3)

A customer wants to use a client script to validate things on a form m order to make sure the submission makes sense. What type of client script would you
recommend to meet this requirement?

A. onSubmission()
B. onSubmit()

C. onLoad

D. onUpdate()
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Answer: B

NEW QUESTION 43

- (Topic 3)

A subject matter expert routinely receives tasks which have been worked by first level support, before receiving the assignment
What could you suggest. to make it easier for the expert to read only the work notes in the Activity log?

A. Click Context menu > Work Notes View

B. Click Personalize icon and select Activity Stream

C. Right click form header > Form Layout > Add Work Notes Section
D. Click Funnel icon and select only work notes

E. Click Context menu > History

Answer: D

NEW QUESTION 45
- (Topic 3)
Tables may be set up with Many to Many relationships. What is a classic example of a scenario where the tables would have many to many relationships?

A. Requests can contain many items; and ltems can be any item from the catalog.

B. Vendors can sell multiple products; and products can be sold by multiple vendors.

C. A Task can trigger many Workflows; and a Workflow can trigger many Tasks

D. A Configuration Item can belong to multiple Classes; and Classes can contain multiple Configuration Items.

Answer: B

NEW QUESTION 49
- (Topic 3)
What capability allows users to create dashboards with widgets to visualize data over time in order to identify areas of improvement?

A. Analytics Reports

B. Performance Analytics
C. Scheduled Reports

D. Reporting

Answer: B

NEW QUESTION 54
- (Topic 3)
What feature do you use to specify which users are able to access a Service Catalog Item?

A. Can Read Role

B. Catalog User Role
C. Can Order Tab

D. User Criteria

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow- platform/page/product/service-catalog-management/task/t_AppUserCrititemsCat.html

NEW QUESTION 58
- (Topic 3)
What is the result of the order in which access controls are evaluated?

A. Ensures user has access to the fields in a table, before considering their access to the table

B. Ensures user can get to work as quickly as possible

C. Ensures user has access to the application, before evaluating access to a module within the application
D. Ensures user has access to a table, before evaluating access to a field in the table

Answer: D

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0541355

NEW QUESTION 61
- (Topic 3)
Which low components allow you to specify when a flow should be run?

A. Trigger and Condition Pill

B. Scope and Trigger Condition
C. Trigger and Condition

D. Trigger Criteria and Clock

E. Condition and Table

Answer: C
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Explanation:

Triggers define when a flow should start running, and conditions are used to specify the specific circumstances under which a flow should run. By combining
triggers and conditions, you can create flows that run only when specific events occur and only for certain types of records.

References:

? ServiceNow Product Documentation: Flow Designer - Overview - https://docs.servicenow.com/bundle/sandiego-application-development/page/administer/flow-
designer/concept/flow-designer.html

? ServiceNow Product Documentation: Flow triggers - https://docs.servicenow.com/bundle/tokyo-application-development/page/administer/flow-
designer/reference/flow-triggers.html

NEW QUESTION 64

- (Topic 3)

Which feature enables business process owners to organize Flow Designer content into unified and digitized cross-enterprise processes via a digitized task board
Interface?

A. Flow Designer

B. Process Automation Designer
C. Process Workflow Designer
D. Workflow Editor

Answer: B

NEW QUESTION 65
- (Topic 3)
What Service Catalog feature do you use to organize items into logical groups?

A. Variable sets
B. Catalog items
C. Sections

D. Categories

Answer: A

NEW QUESTION 69
- (Topic 3)
What access does a user need to be able to import articles to a knowledge base?

A. sn_knowledge_import

B. sn_knowledge contribute
C. Can contribute

D. Can import

Answer: C

NEW QUESTION 74
- (Topic 3)
To apply a Ul Policy to all views, which field should be set to true in its definition record?

A. Inherit

B. Reverse if false
C. On lowed

D. Global

Answer: A

NEW QUESTION 78

- (Topic 3)

An IT user calls the service desk because they need to work on task records. All they can see is Self Service on their homepage when they login to the
ServiceNow instance. What issue could explain this? Choose 2 answers

A. Their user account failed LDAP authentication

B. Their user account is not logged in properly

C. Their user account was not approved by their manager

D. Their user account does not have itil role

E. Their user account does not belong to any groups, which contain the itil role

Answer: AC

NEW QUESTION 81

- (Topic 3)

You have heard about a new application released by SericeNow, You want to try it out, to- see if it might be useful for your company's ServiceNow implementation.
What would be the best way to get hands-on experience with the new application?

A. Check the latest release notes at docs.servicenow.com.

B. Activate the application plug in, on your personal dev instance.

C. Search the wiki for the sales demo request form,

D. Activate the application plug in, on your company's production instance.
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Answer: B

NEW QUESTION 86
- (Topic 3)
Which type of scripts run in the browser?

A. Policies and Client Scripts
B. Access Contral Scripts

C. script Include Scripts

D. Business Rule Scripts

Answer: A

NEW QUESTION 90
- (Topic 3)
Which SericeNow utility gives a Service Desk agent the ability to trace from a Service having an issue, to see which Cis supporing that service have active issues?

A. AL Service Dashboard

B. Cl Health Dashboard

C. Dependency View

D. Event Management Homepage

Answer: B

NEW QUESTION 91
- (Topic 3)
What is the best practice related to using the Default Update Set for moving customizations between instances?

A. Merge Default update sets before moving between instances

B. Submit Default update set to application repository

C. You should not use the Default Update sets for moving between instances

D. Keep Default update set to maximum of 20 records, for troubleshooting purposes

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/reference/default-update-sets.html

NEW QUESTION 92
- (Topic 3)
If a user is on an Incident form and is alerted when they change the value of the Priority field, which type of script executes in the Platform?

A. A server script
B. A client script
C. A fix script

D. A business rule

Answer: B

Explanation:

A client script is a script that runs on the client side, meaning in the user’s browser, and can manipulate the user interface or validate user inputl. A client script
can be configured to run when a form is loaded, when a field value changes, or when a form is submitted?2. In this case, the script runs when the Priority field value
changes and alerts the user.

ReferencesClient scriptsClient script types

NEW QUESTION 95
- (Topic 3)
The wait time for end users is based on the round-trip between the client and the server. What activities are included in the round-trips?

A. Request + Response
B. Save + Update

C. Write + Read

D. Submit + Query

E. Insert + Verify

Answer: A
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-application-development/page/script/client-scripts/concept/client-script-best-practices.html

NEW QUESTION 97
- (Topic 3)
When an administrator sets a policy that is applied to all data entered into the Platform (Ul, Import Sets, or Web Services), where does this policy run by default?

A. Network
B. Server
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C. Client
D. Browser

Answer: B

Explanation:

A policy that is applied to all data entered into the Platform is called a Data Policy. Data policies run on the server side and enforce data consistency by setting
mandatory and read-only states for fields1.

ReferencesData policies

NEW QUESTION 101
- (Topic 3)
Which best describes a field in a SeniceNow table?

A. Afield is a table cell that stores data

B. A field is a table row

C. Afield is an item that appears in a menu list
D. A field is a record in a table

Answer: C

NEW QUESTION 106
- (Topic 3)
Many actions are included with flow designer, what are some frequently used core actions? Choose 4 answers.

A. Wait for Condition
B. Ask for Approval
C. Create Record

D. Wait for Match

E. Look for Update
F. Look Up Record

Answer: BCDF

NEW QUESTION 111
- (Topic 3)
When importing spreadsheet data into ServiceNow, what is the first step in the process?

A. Create Import Set
B. Run Data Scrubber
C. Set Coalesce

D. Define Data Source
E. Select Import Set

Answer: A

NEW QUESTION 115
- (Topic 3)
You are looking at a list of Active incidents. You want to exclude incidents with the state of Resolved. How might you do that?

A. On the list of records, locate the right-click on the Resolved value, select Exclude.
B. Click Funnel icon, click AND, Select Resolved, is Not State click Run

C. On state column title, right-click, select Filter Out > Resolved

D. On Search, select State, type not Resolved, press enter

E. On the list of records, locate and right-click on the Resolved value, select Filter Out

Answer: E

NEW QUESTION 120
- (Topic 3)
What instance resource allows you to access guided tours, information about actions, and instructions an how to use inputs and outputs in your flaw?

A. Community

B. Help Panel (question mark icon)
C. Docs

D. Wiki

Answer: B

NEW QUESTION 122
- (Topic 3)
What is the primary objective of the Display Business Rule?

A. To monitor fields on a form, and provide feedback

B. To use a shared g_scratchpad object, which can be sent to the client, as part of the form
C. To set files to mandatory, hidden, and read-only

D. To define what happens on a form, when a particular fled changes
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Answer: B

NEW QUESTION 126
- (Topic 3)
What type of query allows you to filter list data using normal words, instead of the condition builder?

A. Natural Language Query

B. Alexa Query

C. Machine Learning Query

D. Predictive Intelligence Query
E. Auto-suggest Query

Answer: A

NEW QUESTION 129
- (Topic 2)
On a Form header, what is the three bar icon called?

A. Pancake icon

B. Additional Actions or Context Menu
C. Hamburger icon

D. Cake icon

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-forms/concept/c_FormContextMenu.html

NEW QUESTION 131
- (Topic 3)
What is the definition of a group?

A. An escalation pod

B. A department

C. A collection of users

D. A collection of subject matter experts
E. A team of users

Answer: C

NEW QUESTION 136
- (Topic 2)
Which of the following is used to categorize, flag, and locate records?

A. Search

B. Favorites
C. Tags

D. Bookmarks

Answer: C

NEW QUESTION 137

- (Topic 2)

Two departments (HR Onboarding and Facilities) have come to you, asking for a way for employees to request event room set up services. The requirements are
the same for the form and the task routing to the Facilities’ assignment group.

For HR, the item will be used primarily for the Onboarding coordinators, for employee orientation sessions.

For Facilities, the item will be used for anyone in the company who needs room set up services.

However, both departments have their own service catalogs. What do you do, to support these requirements?

A. Create one Catalog Item for HR Event Room Set Up and one for Facilities Event Room Set Up; then publish each to the appropriate Catalog.
B. Create one Catalog Item for Event Room Set Up; then publish to both Catalogs.

C. Create one Catalog Item for Event Room Set Up; then publish to the Parent Catalog, which is accessible to both HR and Facilities.

D. Create one Catalog Item for Event Room Set Up; then use ACLs to control access.

Answer: C

NEW QUESTION 140
- (Topic 2)
From a form, what would you click to add additional fields to the form? (Choose two.)

A. Context Menu > Form > Layout

B. Context Menu > Configure > Form Layout

C. Context Menu > Configure > Form Design

D. Right click on header > Add > Field

E. Context Menu > Form > Designer

F. Right click on header > Configure > UX Dashboard
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Answer: BD

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-it-service-management/page/product/change-management/task/t _CreateCustomField.html

NEW QUESTION 141
- (Topic 2)
Which ServiceNow resource is a framework that ensures the data your ServiceNow application requires maps correctly to the appropriate CMDB tables?

A. Common Service Data Model (CSDM)
B. Service Mapping Utility (SMU)

C. Service Schema Map (SSM)

D. CMDB Class Manager (CMDBCM)

E. CI Class Manager (CICM)

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/paris-servicenow-platform/page/product/csdm-implementation/concept/csdm-basics.html

NEW QUESTION 145
- (Topic 2)
What is a key difference between Reporting and Performance Analytics?

A. Performance Analytics contains snapshots of data taken over time; Reporting shows only the data as it is, at the moment the report is run.
B. Performance Analytics can show trends; Reports cannot.

C. Reports can be run on a scheduled basis; Performance Analytics cannot.

D. Performance Analytics data can be published to Dashboards; Reports cannot.

E. Performance Analytics shows KPIs; Reporting does not.

Answer: B

NEW QUESTION 146
- (Topic 2)
When testing a catalog item, having a manager approval flows, which of these best practices would you follow? (Choose three.)

A. Make sure the latest flows are activated.

B. Use the instance Incognito setting to quickly toggle between requester and approver.
C. Impersonate the requester to ensure the form works.

D. Make sure the requester's user record has a manager specified.

E. Create and select your Testing Update Set, before starting the test cases.

F. Use your Admin account, so you can approve the items quickly.

Answer: DEF

NEW QUESTION 148
- (Topic 2)
Which icon would you double click, to expand and collapse the list of all Applications and Modules?

Servicennw. senice Management

Self-Service

=]

A. Star

B. Clock

C. Application
D. Funnel

Answer: C
Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/administer/navigation-and-ui/task/uil6-navigator-tasks.html

NEW QUESTION 151
- (Topic 2)
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Which tool should be used to populate commonly used fields in a form?

A. Template

B. Reference Qualifier
C. Formatter

D. Assignment Rule

Answer: A

NEW QUESTION 154

- (Topic 2)

Access Control rules are applied to a specific table, like the Incident table. What is the object name for a rule that is specific to the Incident table and the Major
Incident field?

A. Incident.Major_Incident

B. incident=>major_incident
C. incident<=>major_incident
D. incident||major_incident
E. incident.major_incident

Answer: E

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/contextual-security/concept/acl-rule-types.htmi

NEW QUESTION 159

- (Topic 2)

What are the three permission requirements that must evaluate to true for an access control rule to apply?
Choose 3 answers

A. Conditions
B. table.
C. Roles
D. Script
E. table."
F. table.none

Answer: CDE

NEW QUESTION 160
- (Topic 2)
IntegrationHub enables execution of third-party APIs as a part of a flow. These integrations are referred to as

A. an action

B. a spoke

C. a connection

D. an integration step

Answer: B

NEW QUESTION 165
- (Topic 2)
How is a group defined in ServiceNow?

A. A group is one record stored in the Group Type [sys_user_group_type] table
B. A group is one record stored in the Group [sys_user_group] table

C. A group defines a set of users that share the same location

D. A group defines a set of users that share the same job title

Answer: B

NEW QUESTION 170
- (Topic 2)
What is a no-code approach to control the mandatory or read-only state of a form field?

A. Ul Action

B. Client Script
C. Ul Script

D. Ul Rule

E. Ul Policy
Answer: E

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/field-administration/concept/c_DataPolicy.html

NEW QUESTION 173
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- (Topic 2)
Your company is giving all first line workers a special T-shirt as a recognition for their hard work. Management team wants a way for employees to order the T-
shirt, with the ability to specify the preferred size and color. How would you ensure that only first line workers (non- managers) can submit the order?

A. Create Record Producer and use the Available For list to specify First Line [sn_first_line] role
B. Create Catalog Item and use the Not Available list to specify the Manager Group

C. Create Catalog Item and use the Available For list to specify ITIL [itil] role

D. Create Order Guide and use the User Criteria list to specify First Line [sn_first_line] role

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/orlando-it-service-management/page/product/service-catalog-management/task/t_AppUserCrititemsCat.html

NEW QUESTION 175
- (Topic 2)
What is the primary application used to load data into ServiceNow?

A. Service Level Management
B. Configuration

C. System Import Sets

D. System Update Sets

Answer: C

NEW QUESTION 180
- (Topic 2)
After finishing your work on High Security Settings, what do you do to return to normal admin security levels?

A. Select Normal role

B. Log out and back in

C. Use System Administration > Normal Security module
D. Select Global Update Set

E. End Impersonation

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/security/concept/c_HighSecuritySettings.html

NEW QUESTION 183
- (Topic 2)
When does the Submit button appear on a form?

A. When saving an old record

B. When creating a new record

C. When changing the reference field in an existing record
D. When updating an existing record

Answer: B

NEW QUESTION 186
- (Topic 2)
Which one of the following statements is true?

A. When an incident form is saved, all the Work Notes field text is recorded to the Activity Log field

B. When an incident form is saved, the Work Notes field text is overwritten each time work is logged against the incident
C. When an incident form is saved, the impact field is calculated by adding the Prion:, and Urgency values

D. When an Incident form is saved, the Additional Comments field text is cleared and recorded to the Work Notes section

Answer: D

NEW QUESTION 189

- (Topic 2)

What is the name of the table relationship, where two or more tables are related in a bi- directional relationship, so that the related records are visible from both
tables in a related list?

A. Database View
B. Many to Many
C. One to Many
D. Extended

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/managing-data/concept/c_DataManagement.html
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NEW QUESTION 192
- (Topic 2)
What Is the purpose of the Fitter navigator In the Application Navigator?

A. Filter applications in order of use

B. Quickly navigate to applications and modules
C. Collapse and expand applications

D. List applications In order of Top Requests

Answer: C

NEW QUESTION 195
- (Topic 2)
Which plugin allows users to install multiple applications, application-customizations. or plugins at once?

A. Application Integration and Plugin Delivery (A1PD) SpokeBatch Install

B. Continuous Integration and Continuous Delivery (CICD) SpokeBatch Install
C. Multiple Integration and Process Delivery (MIPD) SpokeBatch Install

D. Quick Integration and Multiple Delivery (QIMD) SpokeBatch Install

Answer: B

NEW QUESTION 197
- (Topic 2)
What is used frequently to move customizations from one instance to another?

. Update Sets

. Code Sets

. Update Packs

. Configuration Logs
. Remote Sets

. Local Sets

. Code Packs

OGTMMmMmoOOm>

Answer: A

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-it-operations-management/page/product/service-mapping/task/export-patterns.html

NEW QUESTION 200
- (Topic 2)

As an IT employee what interface would you use, if you wanted to browse internal IT documentation, like troubleshooting scripts and FAQs?

A. Knowledge

B. ServiceNow Wiki
C. Knowledge Now
D. SharePoint

E. Stack Overflow

Answer: A

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0547260

NEW QUESTION 205
- (Topic 2)
When moving multiple update sets at one time, what might you do to facilitate the move?

A. Batch
B. Verify
C. Test

D. Preview

Answer: A

Explanation:
Reference: https://www.servicenowelite.com/blog/2016/8/7/update-sets

NEW QUESTION 208
- (Topic 2)
What do you activate when you want to add applications or functionality within your development instance?

A. App Package

B. Updated Pack

C. Patch

D. Plugin

E. App Updated Set
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Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/plugins/concept/c_ServiceNowPlugins.html

NEW QUESTION 213
- (Topic 2)
Which one of the following is an accurate list of changes that are captured in an Update Set?

A. Changes made to tables, forms, schedules, and client scripts
B. Changes made to tables, forms, views, and fields

C. Changes made to: tables, form

D. Business Rules, and data records

E. Changes made to: table

F. forms groups, and configuration items (Cls)

Answer: A

NEW QUESTION 217
- (Topic 2)
What are the components that make up a filter condition? (Choose three.)

A. Operator

B. Match Criteria
C. Value

D. Column

E. Field

Answer: ACE

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_Filters.html

NEW QUESTION 219
- (Topic 2)
Where in Flow Designer can users access information about actions that are added to the flow?

A. Virtual Agent Help
B. Local Action Help
C. Help Panel

D. Flow Assistant

Answer: C

NEW QUESTION 222
- (Topic 2)
What controls the publishing and retiring process for knowledge articles?

A. Approval Policies
B. Approval Definitions
C. Workflow Designer
D. Workflows

E. State Lifecycle

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-servicenow-platform/page/product/knowledge-management/reference/r_KnowledgeWorkflows.html

NEW QUESTION 223
- (Topic 2)
What icon do you use to change the label on a Favorite?

A. Clock

B. Hamburger
C. Pencil

D. Three dots
E. Triangle.

F. Star

Answer: C

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0781451

NEW QUESTION 228
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- (Topic 2)
What do you need to do before you can use an Application-based trigger in your flow?

A. Activate application trigger spoke

B. Activate trigger security rules

C. Activate application spoke, and plug-ins as needed

D. Assign Application trigger role [sn_app_trigger_write] to SME
E. Activate application plugins only

Answer: B

NEW QUESTION 233
- (Topic 2)
What kind of data can Import Sets use to populate tables in ServiceNow?

A. CSS, SOAP, and Excel
B. XM

C. CSV, and Excel

D. SOAP, REST, and XML
E. XML, SOAP, and CSS

Answer: B

Explanation:

https://docs.servicenow.com/bundle/orlando-platform-administration/page/administer/import-sets/concept/c_ImportDataUsinglmportSets.html

NEW QUESTION 237
- (Topic 2)

Which certificate-based authentication methods can be enabled so that users can log into the Service Portal? (Select all that apply) Select 2 Answers from the

below options

A. Extended Validation Access (EVA)
B. Organization Verification Card (OVC)
C. Common Access Card (CAC)

D. Domain Authentication Card (DAC)
E. Personal Identify Verification (PIV)

Answer: CE

NEW QUESTION 240
- (Topic 2)

A user wants to create a set of filter conditions, where they want to show records which satisfy two conditions:

Incidents where the state is Closed
Incidents where Assignment Group is Network
After clicking the Funnel icon, what should the user do?

A. Define the first condition; click AND button; define second condition; click Run

B. Define the first condition; click AND button; define second condition; press enter

C. Define the first condition; click OR button; define second condition; press enter

D. Define the first condition; click > icon on breadcrumb, define second condition; click Run
E. Define the first condition; click > icon on breadcrumb, define second condition; press enter

Answer: A

NEW QUESTION 245
- (Topic 2)
What are the steps to retrieve an Update Set?

A. Verify Update Set is Complete, Retrieve, Preview, Apply
B. Verify Update Set is Complete, Test Connection, Apply

C. Verify Update Set is Complete, Test Connection, Commit
D. Verify Update Set is Complete, Retrieve, Preview, Commit

Answer: C

NEW QUESTION 250
- (Topic 2)

An IT manager is responsible for the Network and Hardware assignment groups, each group contains 5 team members. These team members are working on

many tasks, but the manager cannot see any tasks on the Service Desk > My Groups Work list. What could explain this?

= Tasks m Search Number v Search

by

0 All > Assignment group = Network.or.Assignment group = Hardwae

ire

L

A. The Service Desk > My Groups Work list shows active work tasks that are not yet assigned.
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B. The manager does not have the itil role.

C. The manager is not a member of the Service Desk group.

D. The manager is not a member of the Network and Hardware groups.
E. The Assignment Group manager field is empty.

Answer: C

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/users-and-groups/task/t_CreateAGroup.html

NEW QUESTION 255
- (Topic 2)
What are different types of Data Sources, which may be imported into ServiceNow? (Choose four.)

A. Local Sources (i.

B. XML, CSV, Excel)

C. Implementation Spoke
D. DataHub

E. JDBC Connection

F. Network Server

G. LDAP Connection

Answer: ACDF

Explanation:
Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/quebec/servicenow_administrator/app_store_learnv2_importingdata_quebec_data_s
ources

NEW QUESTION 258

- (Topic 2)

A new Service Desk employee in Latin America complains that the create dates and times are incorrect on their Incident list. What would you suggest to fix this
issue?

A. Have them clear their cache.

B. Have them use the gear icon to set the employee’s time zone.
C. Recommend they use Chrome, instead of Explorer.

D. Use the system properties to correct the instance’s time zone.
E. Have them correct the time zone on their computer.

Answer: E

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0659171

NEW QUESTION 259
- (Topic 2)
Which of the following steps can be used to import new data into ServiceNow from a spreadsheet?

A. Select Data Source, Schedule Transform

B. Load Data, Create Transform Map, Run Transform

C. Define Data Source, Select Transform Map, Run Transform
D. Select Import Set, Select Transform Map, Run Transform

Answer: D

NEW QUESTION 263
- (Topic 2)
When designing a flow, how do you reference data from a record, in that flow?

A. Drag the table icon onto the flow definition

B. Use the condition builder to specify the desired values
C. Specify the source table on the data pill related list

D. Drag the data pill onto the flow definition

E. Add the table reference using the slush bucket

Answer: D
Explanation:

Reference: https://developer.servicenow.com/dev.do#!/learn/learning-plans/paris/citizen_developer/app_store_learnv2_flowdesigner_paris_using_flow_variables

NEW QUESTION 267
- (Topic 2)
In addition to the admin role, which one of the following roles allows a user to add or remove fields from a list?

A. personal ize.control

B. personal_list
C. ul_page_admin
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D. ui_action_admin

Answer: A

NEW QUESTION 272
- (Topic 2)

Which ServiceNow capability provides assistance to help users obtain information, make decisions, and perform common work tasks via a messaging interface?

A. Agent Workspace
B. Chat bot

C. Virtual Agent

D. Knowledge Chat
E. Now Support

Answer: C

NEW QUESTION 273
- (Topic 2)

Which of the following protects applications by identifying and restricting access to available files and data?

A. Application Configuration
B. Verbose Log

C. Access Control Rules

D. Application Scope

Answer: D

NEW QUESTION 276
- (Topic 2)
What is a role in ServiceNow?

A. Arole is one record m the Role [sys_user_role] table
B. Arole is one record in the Role luser_sys_role] table
C. Arole is a persona used In Live Feed Chat

D. Arole Is a set of modules for a particular application

Answer: A

NEW QUESTION 278
- (Topic 2)

What function do you use to add buttons, links, and context menu items on forms and lists?

A. Ul Policies
B. Ul Settings
C. Ul Actions
D. Ul Config

Answer: C

Explanation:

Reference: https://docs.servicenow.com/bundle/rome-platform-administration/page/administer/list-administration/concept/c_UIlActions.html

NEW QUESTION 279
- (Topic 1)

The baseline Service Catalog homepage contains links to which of the following components?

A. Record Producers, Order Guides, and Catalog Items
B. Order Guides, Item Variables, and Workflows
C. Order Guides, Catalog Items, and Workflows
D. Record Producers, Order Guides, and Item Variables

Answer: A

NEW QUESTION 280
- (Topic 1)

A knowledge article must be which of the following states to display to a user?

A. Published
B. Drafted
C. Retired
D. Reviewed

Answer: A

NEW QUESTION 281
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- (Topic 1)
What is the Import Set Table?

A. A table where data will be placed, post-transformation
B. A table that determines relationships

C. A staging area for imported records

D. A repository for Update Set information

Answer: C

NEW QUESTION 282
- (Topic 1)
A User is stored in which table?

A. User [sys_user]

B. User [ sys_user_group]
C. User [ syst_user_profile]
D. User [user_profile]

Answer: A

NEW QUESTION 285
- (Topic 1)
When working on a form, what is the difference between Insert and Update operations?

A. Insert creates a new record and Update saves changes, both remain on the form

B. Insert creates a hew record and Update saves changes, both exit the form

C. Insert saves changes and exits the form, Update saves changes and remains on the form
D. Insert saves changes and remains on the form, Update saves changes and exits the form

Answer: B

NEW QUESTION 287
- (Topic 1)
What is (are) best practice(s) regarding users/groups/roles? Choose 2 answers

A. You should never assign roles to groups.
B. You should assign roles to users.

C. You should assign roles to groups

D. You should add users to groups

Answer: CD

NEW QUESTION 291
- (Topic 1)
What are the four knowledge workflows available in the ServiceNow base instance?

A. Approval publish: Request approval from a manager of the knowledge base before moving the article it the publish state
B. Instant Publish: Immediately publishes a draft article without requiring an approval

C. Instant Retire: Immediately retires a published article without requiring an approval

D. Retire Knowledge: Moves a knowledge article to the retired state.

Answer: A

NEW QUESTION 292
- (Topic 1)
What is a way that you can mark a knowledge article for review?

A. Flag article
B. Review
C. Bookmark
D. On Hold

Answer: A

NEW QUESTION 296

- (Topic 1)

Which of the following statements is true when a new table is created by extending another table?

A. The new table archives the parent table and assumed its roles in the database

B. The new table inherits all of the Business Rules, Client Scripts, and Ul Policies of the parent table, but none of the existing fields
C. The new table inherits all of the fields of the parent table and can also contain new fields unique to itself

D. The new table inherits all of the fields, but does not inherit Access Control rules, Client Scripts, and Ul Policies of the parent table

Answer: C
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NEW QUESTION 298
- (Topic 1)

Which one of the following statements best describes the purpose of an Update Set?

A. An Update Set allows administrators to group a series of changes into a named set andthen move this set as a unit to other systems

B. By default, an Update Set includes customizations, Business Rules, and homepages
C. An Update Set is a group of customizations that is moved from Production to Development
D. By default, the changes included in an Update Set are visible only in the instance to which they are applied

Answer: A

NEW QUESTION 302
- (Topic 1)

Business Rules are used to enforce mandatory data on a form.

A. True
B. False

Answer: B

NEW QUESTION 306
- (Topic 1)

Configuration will not affect what others see on their forms.

A. True
B. False

Answer: B

NEW QUESTION 311
- (Topic 1)

Where would you go in ServiceNow to order services and products offered by various departments?

A. Service Catalog

B. Self Service

C. Service Department
D. Customer Service

Answer: A

NEW QUESTION 314
- (Topic 1)

What are the 6 methods available for user authentication?

A. Local Database: The user name and password in their user record in the instance database.

B. Multifactor: The user name and password in the database and passcode sent to the user's mobile device that has Google Authenticator installed
C. LDAP: The user name and password are accessed via LDAP in the corporate directory, which has a matching user account in the database.
D. SAML 2.0: The user name and password configured in a SAML identity provider account, which has a matching user account in the database.

E. OAuth 2.0: The user name and password of OAuth identity provider, which has a matching user account in the database.
F. Digest Token: An encrypted digest of the user name and password in the user record.

Answer: ABCDEF

NEW QUESTION 315
- (Topic 1)

What refers to an application or system that accesses a remote service or another computer system, known as a server?

A. Server
B. Client
C. Script
D. Policies

Answer: B

NEW QUESTION 320

- (Topic 1)

A role is recorded in which table?
A. Role[sys_user]

B. Role[sys_user_profile]

C. Role[sys_user_record]

D. Role[sys_user_role]

Answer: A
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NEW QUESTION 321
- (Topic 1)

Reports can be created from which different places in the platform? (Choose two.)

A. List column heading
B. Metrics module

C. Statistics module

D. View / Run module

Answer: AD

NEW QUESTION 324
- (Topic 1)

Which configuration allows you to use a script to coalesce data in Import Sets?

A. Multiple-field coalesce
B. No coalesce

C. Conditional coalesce
D. Single-field coalesce

Answer: C

NEW QUESTION 325
- (Topic 1)
Which of the following is used to initiate a flow?

A. A Trigger
B. Core Action
C. A spoke

D. An Event

Answer: A

NEW QUESTION 328
- (Topic 1)

What is the difference between Ul Policy and Ul Action?

A. Ul Action can make fields read-only, mandatory, or hidde
B. while Ul Policy can make a save button visible for appropriate users.
C. Ul Policy can make fields read-only, mandatory, or hidde
D. while Ul Action can make a save button visible for appropriate users.

Answer: B

NEW QUESTION 330
- (Topic 1)
What is a Record Producer?

A. A Record Producer is a type of Catalog Item that is used for Requests, not Services

B. A Record Producer creates user records

C. A Record Producer is a type of Catalog Item that provides easy ordering by bundling requests
D. A Record Producer is a type of a Catalog Item that allows users to create task-based records from the Service Catalog

Answer: D

NEW QUESTION 333
- (Topic 1)

Which type of interface enables you to display multiple performance analytics, reporting and other widgets on a single screen?

A. Form

B. List

C. Dashboard
D. Timeline

Answer: C

NEW QUESTION 335
- (Topic 1)

Which technique is used to get information from a series of referenced fields from different tables?

A. Table-Walking
B. Sys_ID Pulling
C. Dot-Walking

D. Record-Hopping

Answer: C
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NEW QUESTION 336
- (Topic 1)
Which of the following is true of Service Catalog Items in relation to the Service Catalog?

A. They run behind the scenes.
B. They are the building blocks.
C. They are optional.

D. They provide options.

Answer: B

NEW QUESTION 341
- (Topic 1)
In what order should filter elements be specified?

A. Field, Operator, then Value

B. Field, Operator, then Condition
C. Operator, Condition, then Value
D. Value, Operator, then Field

Answer: A

NEW QUESTION 344
- (Topic 1)
How are Workflows moved between instances?

A. Workflows are moved using Update Sets

B. Workflows are moved using Transform Maps

C. Workflows are moved using Application Sets

D. Workflows cannot be moved between instances

Answer: A

NEW QUESTION 347
- (Topic 1)
From the User menu, which actions can a user select? (Choose three.)

A. Send Notifications

B. Log Out ServiceNow

C. Elevate Roles

D. Impersonate Users

E. Order from Service Catalog
F. Approve Records

Answer: BCD

NEW QUESTION 348
- (Topic 1)
Which of the following allows a user to edit field values in a list without opening the form?

A. Data Editor

B. Edit Menu

C. List Editor

D. Form Designer

Answer: C

NEW QUESTION 352
- (Topic 1)
Which one of the following statements is a recommendation from ServiceNow about Update Sets?

A. Avoid using the Default Update set as an Update Set for moving customizations from instance to instance

B. Before moving customizations from instance to instance with Update Sets, ensure that both instances are different versions
C. Use the Baseline Update Set to store the contents of items after they are changed the first time

D. Once an Update Set is closed as “Complete”, change it back to “In Progress” until it is applied to another instance

Answer: A

NEW QUESTION 356
- (Topic 1)
Which would NOT appear in the History section of the Application Navigator?

A. Records
B. Ul Pages
C. Lists

D. Forms
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Answer: B

NEW QUESTION 360
- (Topic 1)
Which three Variable Types can be added to a Service Catalog Item?

A. True/False, Multiple Choice, and Ordered

B. True/False, Checkbox, and Number List

C. Number List, Single Line Text, and Reference
D. Multiple Choice, Select Box, and Checkbox

Answer: D

NEW QUESTION 365
- (Topic 1)
Which statement is true about business rules?

A. A business rule must run before a database action occurs

B. A business rule can be a piece of Javascript

C. A business rule must not run before a database action occurs
D. A business rule monitors fields on a form

Answer: B

NEW QUESTION 368
- (Topic 1)
A REQ number in the Service Catalog represents...

A. the order number.

B. the stage.

C. the task to complete.

D. the individual item in the order.

Answer: A

NEW QUESTION 370
- (Topic 1)
Which one of the following statements describes a characteristic of role assignment?

A. Roles can contain other roles, when you are assigned a role, you inherit all the roles within that role
B. Users can click on the Personalize Role feature to try different roles

C. Arole is granted to a user by the System Administrator

D. Each user has a role in the ServiceNow platform

Answer: A

NEW QUESTION 372
- (Topic 1)
When using the Load Data and Transform Map process, what is the Mapping Assist used for?

A. Mapping fields using the Import Log

B. Mapping fields using Transform History
C. Mapping fields using an SLA

D. Mapping fields using a Field Map

Answer: D

NEW QUESTION 373
- (Topic 1)
Ul Action can prompt that an Incident has been successfully submitted.

A. True
B. False

Answer: A

NEW QUESTION 375
- (Topic 1)
For Administrators creating new Service Catalog items, what is a characteristic they should know about Service Catalog variables?

A. Service Catalog variables can only be used in Record Producers
B. Service Catalog variables can only be used in Order Guides

C. Service Catalog variables cannot affect the order price

D. Service Catalog variables are global by default
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Answer: D

NEW QUESTION 377
- (Topic 1)
What is the purpose of a Related List?

A. To create a one-to-many relationship
B. To dot-walk to a core table

C. To present related fields

D. To present related records

Answer: D

NEW QUESTION 381
- (Topic 1)
Data Policy can enforce mandatory data on import.

A. True
B. False

Answer: A

NEW QUESTION 383
FILL IN THE BLANK - (Topic 1)
FILL IN THE BLANK
is a computer program running as a service; a physical computer dedicated to running one or more services, or a system running a database.

A. Mastered
B. Not Mastered

Answer: A

Explanation:
Server

NEW QUESTION 384
- (Topic 1)
Create Incident, Password Reset, and Report outage: what do these services in the Service Catalog have in common?

A. They direct the user to a record producer
B. They direct the user to a catalog property
C. They direct the user to a catalog Ul policy
D. They direct the user to a catalog client script

Answer: A

NEW QUESTION 387
- (Topic 1)
A Service Catalog may include which of the following components?

A. Order Guides, Exchange Rates, Calendars

B. Order Guides, Catalog Items, and Interceptors

C. Catalog Items, Asset Contracts, Task Surveys

D. Record Producers, Order Guides, and Catalog Items

Answer: D

NEW QUESTION 392
- (Topic 1)
What are the three components of a filter condition?

A. Table
B. Value
C. Field
D. Operator

Answer: BCD

NEW QUESTION 394

- (Topic 3)

A task worker asks how they can monitor any updates occurring to recands assigned to him, like responses from customers, What do you suggest?
A. Open an Agent workspace tab for each record he wants to monitor

B. Select Service Desk > My Work Dashboard
C. Click on the eyeglass icon t
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D. expand the Monitor frame
E. On My Work list, select the Activity Stream icon to show a frame with live updates

Answer: D

NEW QUESTION 396
- (Topic 3)
On a form header, what icon would you click to access Template features?

A. Paper clip

B. More options (...)
C. Stamp

D. Context Menu

Answer: B

NEW QUESTION 398

- (Topic 3)

What process allows users to create, categorize, review approve and browse important information in a centralized location that is shared oy the entire
organization?

A. Self Service Management

B. Knowledge Management

C. Knowledge-Centered Management
D. Information Portal Management

E. Business Information Management

Answer: B

Explanation:

Knowledge Management is the process that allows users to create, categorize, review, approve and browse important information in a centralized location that is
shared by the entire organizationl. Knowledge Management helps users to find relevant and accurate information quickly, reduce the need to rediscover
knowledge, and improve the quality of service and customer satisfactionl.

References
? Knowledge Management - ServiceNow1

NEW QUESTION 403
- (Topic 3)
What ServiceNow feature allows you to include data from a secondary related table on a report?

A. SQL

B. Dot Walking
C. Quter Join
D. Joins

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-now-intelligence/page/use/reporting/concept/c_HowToAccessRelatedTables.html

NEW QUESTION 408
- (Topic 3)
What would you do, on a list, if you wanted to show the records in groups, based on the column category? (Choose two.)

A. On list Context Menu, select Group By > Category

B. On the Filter Menu, select Group By > Category

C. Click Group On icon, select Category

D. On Navigator Filter, type tablename.group.category and press enter

E. On the Category column title, click Context menu > Group By Category

Answer: AE

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-platform-user-interface/page/use/using-lists/concept/c_GroupedLists.html

NEW QUESTION 409
- (Topic 3)
What actions are taken to filter a long list of records to show only those with the Category of Hardware?

A. On Breadcrumb, click the > icon, type Hardware and click enter

B. On the Category column header, right-click and select Show > Hardware

C. On the list, locate and right-click on the value Hardware, select Show Matching
D. Right-click on magnifier type Hardware and click enter

E. Click Funnel icon, type Hardware and click enter

Answer: C
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NEW QUESTION 413
- (Topic 3)
What is the language used for scriptingin ServiceNow?

A. JavaScript
B. C++

C. PHP

D. Python

Answer: A

NEW QUESTION 416

- (Topic 3)

What contains the configuration changes made in an instance (i.e. changes in a form) and
helps to implement the changes from the Dev environment to another environment?

A. Update sets

B. Transform maps

C. System dictionaries
D. Import sets

Answer: A

Explanation:

Update sets are the configuration changes made in an instance, such as changes in a form, that can be exported from one instance and imported into another.
This helps to implement the changes from the Dev environment to another environment, such as Test or Prod. Update sets capture the changes made to system
properties, Ul actions, business rules, workflows, and other customizations.

Referencesl: Get started with update sets - ServiceNow - Now Support2: Product Documentation | ServiceNow3: Update Set in ServiceNow, Captured, Non-
Captured, Commit, Import ...4: In depth Concepts Update Set in ServiceNow - Basico ServiceNow Learning5: Retrieving and committing update sets between
different ... - ServiceNow

NEW QUESTION 417
- (Topic 3)
A department manager asks an analyst to build some reports. Where do you recommend the analyst start?

A. Report Dashboard > Create New
B. Reports > Getting Started

C. Performance Analytics > Reports
D. Self-Service > Reports

E. Reports > Create New

Answer: E

Explanation:
Reference: https://kstate.service-now.com/kb_view.do?sysparm_article=KB12492

NEW QUESTION 420
- (Topic 3)
Which helps to visualize configuration items and their relationships?

A. Transform Map

B. Schema Map

C. Tables

D. Flow Design

E. Dependency View

Answer: E

Explanation:

The Dependency View provides a visual representation of the relationships between configuration items (CIs) in ServiceNow. It allows you to see how Cls are
connected and how changes to one Cl may impact others.

References:

? ServiceNow Product Documentation: Configuration item relationships in the CMDB

- https://docs.servicenow.com/bundle/vancouver-servicenow- platform/page/product/configuration-management/concept/c_CIRelationships.html

? ServiceNow Community: How to display dependencies for Cls in the Dependency

View - https://www.servicenow.com/community/service-management-forum/load- a-specific-dependency-view-map/m-p/410421

NEW QUESTION 425

- (Topic 3)

What are examples of Ul Actions relating to forms?
Choose 3 answers

A. Form Context Menu
B. Form View

C. Form Buttons

D. Form Links.

E. Form Columns

Answer: ACD
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NEW QUESTION 429
- (Topic 3)
Which ServiceNow capability allows you to provide knowledge articles, via a conversational messaging interface?

A. Agent Assist

B. Virtual Agent

C. Now Messenger
D. Connect Agent

Answer: B

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-release-notes/page/release-notes/analytics-intelligence-reporting/virtual-agent-rn.htmi

NEW QUESTION 430
- (Topic 3)
Which admin role is required to make changes to High Security Settings?

A. security _admin
B. sn_ad_admin

C. high_sec_admin
D. admin

Answer: A

NEW QUESTION 435

- (Topic 3)

You have an existing customer, who is using workflows for their catalog items. Their existing purchasing policy is to require approval for any request that totals
over 31000. However, management wants to change the approval threshold to 31500. Which

workflow would you update to make this change?

A. Services Approval Processing

B. 6 Services Catalog Item Request
C. Service Catalog Request

D. Purchasing Process Flow

Answer: C

NEW QUESTION 437
- (Topic 3)
What do you click when you have made modification to your report, and your want to see the results without saving?

A. Execute
B. Tryir
C. Run
D. Test
E. Preview

Answer: D

NEW QUESTION 442

- (Topic 3)

When looking at a long list of records, you want to quickly filler, to show only those which have Shon Description containing email
How might you do that?

A. Click List Magnifier to expand column search, on Short Description, type “email, click enter
B. Click List Magnifier to expand column search, on Short Description, lype *email, click enter
C. Click List Magnifier to expand column search, on Short Description, type email, click enter
D. On Search box, select text, type email, click enter

Answer: A

NEW QUESTION 445
- (Topic 3)

ServicenoOw Al Favorites  Admin

Incident
New record

2

You are editing a new incident record and would like the Save" Dutton to be located on the Form header. Which action would need to be taken for that button to
appear?
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A. All > System Properties > Ul Properties > Turn on the glide.ui.advanced* property
B. Context Menu > Form Design > add the Save" button

C. All > System Properties > Ul Properties > Turn on the Save" button

D. Context Menu > Form Layout > add the Save* button.

Answer: C

Explanation:

To add the Save button to the form header, users need to turn on the system property glide.ui.save_button, which enables the Save button on all forms1. Users
can navigate to All > System Properties > Ul Properties and search for the property name, then set the value to truel. Alternatively, users can use the
sys_properties.list URL suffix and filter by the property namel.

References

? How to add or enable Save Button on all the forms across a Servicenow Instance - Support and Troubleshooting - Now Support Portal

NEW QUESTION 450
- (Topic 3)
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An order from the Service Catalog has been placed. Two records in the Platform are
created as a result. Which two records are associated with tins newly ordered item? Choose 2 answers

A. A record of sc_task

B. A record of sc_req_llem table
C. A change record

D. An Incident record

E. A problem record

Answer: AB

NEW QUESTION 451
- (Topic 3)
What does ServiceNow recommend as a best practice regarding data imports?

A. Adjust your Transform maps, after the data is loaded into the target table.

B. Use extremely large Import Sets, instead of multiple large Import Sets.

C. Create a new Import set table for each new data load.

D. Plan time before your import to remove obsolete or inaccurate data.

E. Monitor data quality and clean imported data, using the Data Scrub Workspace.

Answer: D

Explanation:

This is a best practice because it reduces the amount of data that needs to be imported, transformed, and stored in ServiceNow, and improves the data quality
and performance of the system1.

ReferencesIimport and export resources page

NEW QUESTION 454
- (Topic 3)
What access does a user need to be able to import anicies to a knowledge base?

A. Can contribute

B. sn_knowledge_contripute
C. sn_knowledge_import

D. Can import

Answer: A

NEW QUESTION 455
- (Topic 3)
When looking at a long list of records, you want to quickly filter, to show only those which have Category of Hardware. How might you do that?

A. On the list, locate and right click on the value Hardware, select Show Matching
B. Click Funnel ten, type Hardware and click enter

C. On the Category column header, right click and select Show > Hardware

D. Right dick on magnifier, type Hardware and click enter

E. On Breadcrumb, click > icon, type Hardware and click enter
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Answer: A

NEW QUESTION 458
- (Topic 3)
One related list, which buttons are commonly used for managing the records on the list? Choose 3 answers

A. Publish
B. New
C. Ada
D. Manage
E. Edit

Answer: BCE

NEW QUESTION 463
- (Topic 3)
What are the steps for applying an update set to an instance?

A. Retrieve, Preview, Commit
B. Specify, Transform, Apply
C. Retrieve, Assess, Apply
D. Get, Test, Push

E. Pull, Review, Push

Answer: A

Explanation:
Reference: https://docs.servicenow.com/bundle/rome-application-development/page/build/system-update-sets/hier-update-sets/concept/us-hier- overview.html#us-
hier-overview

NEW QUESTION 465
- (Topic 3)
Which system property is added and set to true in order to see impersonation events in the System Log?

A. glide user_setting

B. glide sys all_jmpersonation

C. glide sys log_jmpersonabon
D. glide.impersonation_setting
E. glide sys admin_login

Answer: C

Explanation:

The system property glide.sys.log_impersonation is added and set to true in order to see impersonation events in the System Log2. This property enables logging
of

impersonation events in the Event [sysevent] table, which can be accessed by navigating to System Logs > Events2.

References

? How to find the history of impersonations - Support and Troubleshooting - ServiceNow

NEW QUESTION 470
- (Topic 3)
What resource can you use to view details of the tables and configuration items (Cls) associated with a particular use case?

A. Scenario Dashboard

B. Cl Use Case Modeler

C. CMDB Use Case Modeler

D. Common Service Data Model (CSDM) product view

Answer: D

Explanation:
Reference: https://docs.servicenow.com/bundle/quebec-servicenow-platform/page/product/csdm-implementation/reference/cmdb-use-case.html

NEW QUESTION 472

- (Topic 3)

What features are available in Knowledge Management, to support continuous improvement on the knowledge articles?
Choose 4 answers

A. Submit KB Errata

B. Add Comments

C. CC Click frowning icon
D. Tag as Helpful

E. Flag Article

F. Rate with Stars

Answer: BDEF
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NEW QUESTION 476
- (Topic 3)

If a knowledge base has no access details specified, what users are able to read articles in that knowledge base?

A. itil users

B. Any user with an article's permalink
C. Any active user

D. No users

E. Users with kb_user role

Answer: C

Explanation:
Reference: https://support.servicenow.com/kb?id=kb_article_view&sysparm_article=KB0623654

NEW QUESTION 481
- (Topic 3)
What are benefits of assigning work tasks to a group, rather than to an individual? (Choose four.)

A. Group members can choose their tasks from My Groups Work
B. Groups can assign tasks to users based on on-call schedules
C. Site support members can pick tasks, based on Location

D. Groups can assign tasks to users based on skills

E. Group members can avoid tasks, which are nearing SLA breach
F. Groups can assign tasks to users based on availability

Answer: BCDF

NEW QUESTION 485

- (Topic 3)

When moving a homepage or dashboard between instances, what must you remember?
A. Create a separate update set for them

B. They are automatically added to the update set

C. Manually add them to the update set

D. They cannot be moved via update set

Answer: C

NEW QUESTION 489
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